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Chapter 1 Getting Started

This chapter applies to all users. It contains links to CODE V system requirements, describes the
CODE V license methods, and tells you how to contact CODE V Support.

CODE V System Requirements

Before installing, confirm that your computer meets the system requirements required to run CODE V.
Additional requirements exist depending on the licensing method used and whether licensing is
centrally managed. See Licensing Requirements on page 6

Operating systems supported

e Microsoft Windows 10 and Microsoft Windows 11, 64-bit, with the latest updates

e Microsoft Windows Server Standard 2012 R2 and Windows Server Standard 2016 with the latest
updates. (You must use a floating license to run CODE V on Microsoft Windows Server Standard)

RAM required

* 2 GB minimum, 3 GB recommended

* 4 GB recommended for parallel processing with 8 or more cores. (Parallel processing is supported
by CODE V's optimization and Beam Synthesis Propagation features. Use of 4 GB RAM requires a
64-bit version of Windows)

Display Resolution

* 768 pixels, minimum vertical resolution

* 1920 x 1080 pixels or higher, recommended resolution
Available USB port

*  Required when using a CODE V license dongle
Processors

e Intel or AMD processors that support x64

* CODEV includes several built-in optical analyses that support multi-processing on PCs with
multiple cores. These functions include optimization, Beam Synthesis Propagation, and select
Macro-PLUS functions.

e Intel Itanium processors are not supported
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Chapter 1 Getting Started

Note that hardware and system requirements for computers that will run CODE V are also online:

https://www.synopsys.com/optical-solutions/codev/hw-systems.html
PDF Viewer

The documents in the CODE V Documentation Library are provided as Portable Document Format
(PDF) files. You are able to view PDF files in any PDF viewer but they may not support PDF features
such as links that you can click to jump to another document. To use full PDF features, you must have
Acrobat Reader version 8.x or higher installed on your computer and set as your default PDF viewer.
Note that for many systems, the default PDF viewer is a browser (e.g., Edge, Chrome).

Licensing Requirements

CODE V provides two methods for licensing:
+ CODE V Legacy Licensing

This method of licensing is used in releases up to and including CODE V 2024.03. Customers who
are migrating from previous versions of CODE V to 2024.03 should continue to use Legacy
Licensing unless informed otherwise by your Synopsys Optical Solutions representative (or your
local application license administrator). Legacy Licensing is the default installation choice. For
additional information, see CODE V Legacy Licensing Requirements.

*  Synopsys Common Licensing (SCL)

This method of licensing is available for new customers beginning with CODE V 2023.03. SCL is
the license system used by many Synopsys products. You will be instructed by a Synopsys Optical
Solutions representative (or your local application license administrator) whether to use SCL.
During installation, you must select SCL to install it. For additional information, see Synopsys
Common Licensing Requirements on page 8.

To install CODE V with either of these licensing methods, you must have license keys provided by
Synopsys Optical Solutions via SolvNetPlus SmartKeys or your local CODE V software distributor.

Note: Host IDs are specific to each licensing method and are not interchangeable between the
two methods.

For information on choosing between these two types of licensing, see:
https://www.synopsys.com/optical-solutions/support/choosing-license-option.html

The following modules require a separate license that may be purchased as an add-on to an SCL license:
*  MetaOptic (CVMOD_BASE)
*  Highly Aspheric Lens Desensitization - SNA (CVIMEASPDESENS)
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Chapter 1 Getting Started

CODE V Legacy Licensing Requirements

With CODE V Legacy Licensing, you can run CODE V using either a fixed license or a floating license.

* A fixed license allows you to run CODE V only on the computer on which it is installed (see
Installing CODE V with Legacy Licensing on page 11).

*  Afloating license allows you to run CODE V on any client computer installed on the same network
as a Floating License Manager server (see Installing CODE V with a Floating License (Legacy
Licensing) on page 17).

The number of users that can use CODE V concurrently is limited to a predetermined number by the
license management software.

To install CODE V with CODE V Legacy Licensing, you must have:

* A dongle acquired by you or your site’s license administrator from your local Synopsys Sales
Representative.

*  An available USB2.0 (or higher) port (for Type A).
* Ifyou will be running CODE V with a floating license, you must also have:
—  TCP/IP network protocol.

— Floating license manager software provided by Synopsys Optical Solutions. This guide
provides instructions for installing the Synopsys Optical Solutions Floating License Manager
(a Sentinel RMS license manager that has been customized for Synopsys Optical Solutions
software), which is provided on SolvNetPlus. See Using SolvNetPlus to Obtain CODE V
Software and Licenses on page 51 for details.
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Chapter 1 Getting Started

Synopsys Common Licensing Requirements
With Synopsys Common Licensing (SCL), you can run CODE V using either a nodelocked license or a
network license.

*  Anodelocked license allows you to run CODE V only on the computer on which it is installed (see
Installing CODE V with an SCL Nodelocked License on page 39).

* Anetwork license, which is installed on a network server running the SCL license server, allows
you to run CODE V on any computer on the same network (see Installing and Managing an SCL
Network License on page 45).

The number of users that can use CODE V concurrently is limited to a predetermined number by the
license management software.

The CODE V product installer installs both CODE V and SCL. The installation process differs
depending on the intended use of your computer:

* A computer that runs CODE V where its license is not managed by an SCL license server and is
installed as Nodelocked. A nodelocked license allows you to run CODE V only on the computer on
which it is installed. See Installing CODE V with a Nodelocked License on page 40.

* A computer that runs CODE V where its license is managed by a license server and is installed as a
Network (Client Installation). See Installing CODE V on Client Machines on page 49. This client
computer must:

—  be set up with the server name and port number (the default port is 27020) of one or more
license servers. Your company’s SCL license administrator will provide you with that
information.

—  be on the same network as the license server.
— communicate with the license server using the TCP/IP network protocol.

* A computer that will manage SCL network licenses for other computers is installed as a Network
(Server Installation). The SCL license administrator uses this computer to manage licensing for
their site. A site may have more than one license server. This computer must:

—  be on the same network as the network clients running CODE V.
— use the TCP/IP network protocol.

Note that while the CODE V software is installed to this computer by default, it will not use a
network license unless CODE V is run on the computer.

If your company uses dongles as a part of their licensing method, the nodelocked computer and license
server will need:

* A dongle acquired by you or your site’s license administrator from your local Synopsys Sales
Representative.

*  An available USB2.0 (or higher) port (for Type A).

If you are the CODE V license administrator or IT administrator who will install the Synopsys Common
Licensing server, see also Selecting a License Server on page 46.
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Chapter 1 Getting Started

Where You Get Your Installation Files

Where you get your files depends on how you purchased CODE V:

Customers who work directly with Synopsys Optical Solutions will retrieve their software and
license keys from the Synopsys SolvNetPlus website. For details about obtaining CODE V
software and license key files, see Appendix A, “Using SolvNetPlus to Obtain CODE V Software
and Licenses” on page 51.

Customers who work with a CODE V software distributor will obtain their software and license
keys from their local distributor. See the Synopsys Optical Solutions Group Global Contacts page
for contact information.

Contacting Customer Support

Need expert help using our software?

Open a support ticket in SolvNetPlus. Learn more about how to access and use Synopsys
SolvNetPlus.

Email codev_support@synopsys.com.

The SolvNetPlus Knowledge Base features a collection of searchable technical articles, example
files, macros, release notes, FAQs, and more, available at any time. First log into SolvNetPlus, then
go to the Collection of Optical and Photonic Solutions Knowledge Article.

Visit our main Support page for an overview of how to access product learning, self-help, and other
resources.

Visit our Licensing and Installation Help page.

View our list of global support contacts.

CODEV Installation Guide 9
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Chapter 2 Installing CODE V with Legacy
Licensing

This chapter describes how to install CODE V with a fixed license, which allows you to run CODE V
only on the computer on which it is installed. Note that all instructions are for the Microsoft Windows
operating system.

About Fixed and Floating License

You can run CODE V using either a fixed license or a floating license. A fixed license allows you to
run CODE V only on the computer on which it is installed. A floating license, which is installed on a
network server, allows you to run CODE V on any client computer installed on the same network (see
Installing CODE V with a Floating License (Legacy Licensing) on page 17). The number of users that
can use CODE V concurrently is limited to a predetermined number by the license management
software.

What You Need for Fixed License Installation

Fixed licenses are standalone software copies to be used on one computer only. You will need the
following to run CODE V on a fixed-license system:

» USB Dongle — the dongle comes with a label that shows its Host ID.

* License Key File — a license key file that corresponds to your CODE V license and to the Host ID
of the USB dongle you are using.

* CODE V - You need a copy of CODE V installation files.

For details, see Appendix A, “Using SolvNetPlus to Obtain CODE V Software and Licenses” on
page 51.

distributor to obtain your software and license. See the Synopsys Optical Solutions Group Global

% Note: For customers working with distributors, please contact your local CODE V software
Contacts page for contact information.
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Installing CODE V

These instructions assume that you have already have the USB dongle, a license key file and the
CODE V installation files. Your working folder is the location where your user-created files are
stored. By default, your working folder is set by default to C:\CVUSER. You can change this location
during installation or in CODE V after installation.

1.
2.
3.

Log on to your computer as Administrator.

Navigate to the folder that contains the CODE V installation package.
Double-click the file CODEVversion.exe.

where version is the version number for the release.

— Ifa User Account Control dialog box is displayed with the message Do you want to allow this
app to make changes to your PC?, click Yes to continue.

The installation files are extracted, and then the Welcome to the InstallShield Wizard page is
displayed.

Click Next to continue to the License Agreement page.

If you accept the agreement, click Yes to continue to the Choose Destination Location page.

To accept the default location for the program, click Next.

The Choose Working Folder page is displayed. The working folder is used to store your user files.
To accept the default location for the working folder, click Next.

— If you previously installed CODE V you will be prompted to confirm whether to use the
existing directory. Click Yes to accept and continue to the License Installation Options page.

— If'this is a new installation, you will continue to the License Installation Options page.

The License Installations Options page informs you that CODE V Legacy Licensing will be used.
Click Next.

When asked to choose the type of license to use, be sure that the Fixed License option is selected
(this is the default setting).

License Installation Options @

Fleaze choose the type of CODE Y licenze that will be used:

Floating [Metwork)] License

Server hostname or
IPv4 address:

10. Click Next to continue.

11. In the Start Copying Files page, confirm your information.

— If the information is correct, click Next.

— Ifacorrection is needed, use the Back and Next buttons to navigate between pages. Make your
corrections and then return to this page before clicking Next.
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Chapter 2 Installing CODE V with Legacy Licensing

12. When the installation is complete, click Finish to close the wizard.

CODEV - InstallShield Wizard

InstallShield Wizard Complete

CODE Y inztallation has been successfully completed.

The CODE ¥V Documentation Library requires Adobe
Reader. You can download Adobe Reader from Adobe
Systems' Web site: www.adobe.com,

< Back Cancel

If you already have a license key for this product, skip to “Installing a License Key File for a
Fixed License” on page 15. If you do not yet have a license key, continue with “Obtaining the
Host ID for a License Dongle” on page 14.
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Chapter 2 Installing CODE V with Legacy Licensing

Obtaining the Host ID for a License Dongle

A license key is designed to work for only one USB dongle, so the license key is associated with a
unique value encoded on the dongle called a Host ID. Before you can request a license key you must
know the Host ID for the license dongle. The Host ID is printed on a label on the USB dongle. You
can also obtain the Host ID by running GetHostID, which reads it from the dongle. If you need to
provide your Host ID to CODE V Support or Sales, the recommended method is to use GetHostID to
generate a file that you can send. Follow these steps to run the GetHostID utility.

1. Insert the USB dongle in an active USB port. The beacon on the dongle should be illuminated. If
not, try connecting it to a different USB port.

2. Click the Windows Start button and select CODE V 2024.03 > GetHostID.

In the following figure, the GetHostID utility displays two lines under the Read Dongle Host ID
button, which indicates that two USB dongles are active on this computer.

‘T GetHostlD Version RS

Dongle Host 1D

Fiead the Host ID from a USE dongle. Be sure that the dongle
and the dongle device driver are properly installed before uzing
thiz option. Click the Read Dongle Host ID button if the Host 1D
iz not dizplayed below.

Fiead Dongle Host 1D

4001 KMPLILFPR3S7PM
Dongle Host IDs 80-1w3ELIRRETENESGR

Host ID File

Create a file with a complete zet of Host 1Dz for this computer.
Uze thiz option only if requested by Customer Support.

C:AUszershPublichDesktophHost D s bt _

“wiite Host [D File

Hardware Host (D
C14G219GIK2RWGEES

Done

If the box is empty, click the Read Dongle Host ID button. If the box remains empty, check the
dongle to see whether the LED on it is lit. Light indicates that the dongle has been plugged-in
properly. If the LED is not lit, check the connection or try inserting the dongle into a different
USB port.

3. To create a HostIDs text file (.TXT) that you can send to CODE V Support or Sales, in the
GetHostID dialog box click Write Host ID File and then click OK. (If you cannot send the Host
IDs file, open the file, copy the contents of the file and paste it into an email message that you
send to Customer Support or Sales.)

4. To copy the Host ID, select the Host ID, right-click and then click Copy. You can then paste the
Host ID into your desired destination.

5. Click Done to close the GetHostID utility.
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Chapter 2 Installing CODE V with Legacy Licensing

6. Continue with “Retrieving License Keys” on page 58 for instructions on retrieving your license
key file from the Synopsys SolvNetPlus website. After you have your license key, go to “Installing
a License Key File for a Fixed License” on page 15.

Installing a License Key File for a Fixed License

A valid license key file must be installed before you can run CODE V. This procedure assumes that
CODE V is installed (see “Installing CODE V” on page 12) and that you have your license key file
(“Retrieving License Keys” on page 58).

box will be displayed. Insert the USB dongle in an active USB port and then click Install License in

% Note: Ifyou start CODE V before you install your license key file, the License Manager Error dialog
the error dialog box to display the Fixed License Installer. Skip to step 3 in the following procedure.

Follow these steps to install your license key file.
1. Insert the USB dongle in an active USB port.

2. To install your license key file, click the Windows Start button and select CODE V 2024.03 >
Fixed License Installer.

The Fixed License Installer is displayed.

Fixed License Installer Version — *

Application: CODE Y

Install Fized License File

| L

Start Application After Installing License File

Install

3. Click the browse button [ - .
4. Navigate to the license key file, select it, and click Open.
The path to the license key file is shown in the Fixed License Installer.

5. (Optional) The Start Application After Installing License File is selected by default. You can
clear the check box, if desired.

6. Click Install.

The license key file is installed. If the Start Application After Installing License File check box
was selected, CODE V starts automatically.
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Chapter 2 Installing CODE V with Legacy Licensing

Modifying Legacy License Options

If you need to change the Legacy license type for your CODE V installation (fixed or floating) or
change the host name of the license server to use with a floating license, use the following procedure.

1. Search for and open Add or Remove Programs.

2. In Programs and Features, click the CODE V version you want to modify and then click
Uninstall.

3. When Windows asks if you want to uninstall, click Uninstall.

4. In the InstallShield Wizard Welcome page, the Modify Licensing option is preselected.

CODE V - InstallShield Wizard ﬁ

Welcome
Modify, repair, or rermove the program.

Wielcome to the CODE Setup Maintenance program, This prograrm lets you rmodify
the current installation. Click one of the options below,

@) Modify licensing

-', Select between fixed or network licensing mode.
.

: Repair
--r Reinstall all program features installed by the previous setup,
ta)]

_Remove

‘e Remove all installed features,

Q2

< Back Cancel

5. Click Next.
6. In the License Installation Options page, click Next.

7. Select the type of license to use. If you are switching to a floating license, enter the server
hostname or IPv4 address for the floating license server. Click Next

License Installation Options @
Fleaze choose the type of CODE ¥ licenze that will be used:
_ Fixed Licenze

@ Floating [Metwork] License

Server hostname or
|Pv4 address: MyServer] J

8. On the Maintenance Information page, confirm your changes and click Next.

9. Click Finish to close the wizard.
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Chapter 3 Installing CODE V with a Floating
License (Legacy Licensing)

This chapter describes how to install CODE V so that a set of CODE V floating licenses (for Legacy
Licensing) can be shared by a group of computers on the same network. The number of users that can use
CODE V concurrently is limited to a predetermined number by the licensing software. A single user can
open up to eight concurrent CODE V sessions per floating license per computer. If a user opens more than
eight concurrent CODE V sessions on the same computer, an additional floating license will be used (if
available). Note that all instructions are for the Microsoft Windows operating system.

The floating license capability requires Synopsys Optical Solutions Floating License Manager, which is a
Sentinel RMS license manager that has been customized for Synopsys Optical Solutions software. If you
install other Synopsys Optical Solutions software products, they will share the same license management
software, and their licenses will be written to the same license key file. The applications cannot share
licenses; they will share only the license server software.

Note: Installing a floating license requires system-administration level training, and should be performed
by someone who is familiar with your network structure. Also, note that you must be logged in as
administrator on the license server.

The steps for installing CODE V to run with a floating license are:
1. Selecting a License Server on page 18
Installing the Floating License Manager on the License Server on page 19

Obtaining the Host ID for a License Dongle on the License Server on page 26

Installing CODE V on Client Machines on page 28

2
3
4. Installing the License Key for a Floating License on page 27
5
6. Optional: Managing Floating Licenses on page 30

7

Optional: Logging Floating License Usage on page 35

CODEV Installation Guide ¢ 17



Chapter 3 Installing CODE V with a Floating License (Legacy Licensing)

What You Need for Floating License Installation

Floating licenses are run on a license server, and operate as a service to client computers attached to the
network. The license server and client computers must be able to communicate with each other using the
UDP protocol. You will need the following items to run CODE V:

License Server
*  USB Dongle — the dongle comes with a label that show its Host ID.

* License Key File — a license key file that corresponds to your CODE V license and to the Host ID of the
USB dongle you are using.

*  Floating License Manager software provided by Synopsys Optical Solutions. This guide provides
instructions for installing the Synopsys Optical Solutions Floating License Manager (a Sentinel RMS
license manager that has been customized for Synopsys Optical Solutions software). See also “CODE V
System Requirements” on page 5.

CODE V Client

* CODE V - You need a copy of CODE V installation files. Note that the license key file is needed only
on the license server; no license key file is needed on client computers.

*  Server Host Name — the name of the server that is hosting the floating license manager. You must enter
this information during installation.

Selecting a License Server

Before installing any software, you must identify the computer that will act as the floating license server.
This must be a computer connected to a network that can grant access to one or more client machines.

Note: The Synopsys OSG Floating License Manager communicates with its clients over port 5093 using
the UDP protocol. If you will be managing licenses for client computers across different subnets, you must
configure your routers or firewalls to allow two-way communication across this port.
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Installing the Floating License Manager on the License Server

Follow these steps to install the Floating License Manager (FLM) on the license server. You obtain the
Synopsys Optical Solutions Floating License Manager software from the same source that provides your
CODE V software (e.g., SolvNetPlus or your local distributor). See Downloading CODE V Software from
SolvNetPlus on page 53.

Note: Whenever a new version of CODE V is released, the software on the client machines must be
updated. Check the latest CODE V Release Notes to see if the Floating License Manager software and/or
the license key file must also be updated.

1. Log on with administrator privileges to the computer that will act as the license server.

2. Ifyou have previously installed the either the ORA or OSG Floating License Manager, it also installed
the Sentinel RMS License Manager software; you must uninstall both before installing the latest
version.

a. Open Control Panel and select Programs and Features.

b. Select the program to uninstall and then click Uninstall/Change.

c. Follow the instructions on screen.

d. Repeat these steps to uninstall additional software.
3. Navigate to the folder where you downloaded the Floating License Manager, FloatinglL Mversion.exe.
4. Double-click the file FloatingL.M.exe.

The WinZip Self-Extractor for the OSG Floating License Manager installation is displayed.

WinZip Self-Extractor - FloatingLM.

| | 05G Hoating License Manager instaliation
Click Setup to begin.

About

5. Click Setup.
The Welcome screen for the OSG Floating Manager Admin Tools wizard is displayed.

ﬁ 056G Floating License Manager Admin Tools ' - InstallShield Wizard X

Welcome to the InstallShield Wizard for 056
4“ Floating License Manager Admin Tools

A

The InstallShield(R) Wizard will install OSG Floating License
Manager Admin Tools on your computer. To continue, dick
Mext,

WARMIMG: This program is protected by copyright law and
international treaties.
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6.

7.

Click Next.

The License Agreement screen for the OSG Floating License Manager Admin Tools is displayed.

ﬁ 056G Floating License Manager Admin Tools - InstallShield Wizard X

License Agreement

Please read the following license agreement carefully.

SYNOPSYS A
END-USER SOFTWARE LICENSE AND MAINTENANCE AGREEMENT
(OPTICAL SOLUTIONS PRODUCTS)

This agreement covers the Optical Solutions Products and related services you

license (or purchase) from Synopsys or a Synopsys designated distributor,

regardless of any other agreement you may have with Synopsys or with any entity
lacquired by Synopsys (including Optical Research Associates or ESoft Design

(Group, Inc.). This agreement also supersedes and replaces any license agreement

that may be provided with the Optical Solutions Products, including any provided in
*shrink-wrap” or “click-through” format. This agreement will survive unless and w

(@)1 accept the terms in the license agreement

(C)1 do not accept the terms in the license agreement

Instalshield

Click the I Accept option and click Next to continue.

The Ready to Install screen is displayed.

ﬁ (56 Floating License Manager Admin Tools - InstallShield Wizard x

Ready to Install the Program
The wizard is ready to begin instalation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

< Back Install Cancel
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8. Click Install.

The progress screen is displayed while the software is installed.

ﬁ 056G Floating License Manager Admin Tools' - InstallShield ..  — x

Installing 05G Floating License Manager Admin Tools
The program features you selected are being installed.

Flease wait while the InstallShield Wizard installs 056G Floating License
Manager Admin Tools . This may take several minutes.

Status:
Copying new files

Instalshield

9. Accept the default settings for all options.

The Welcome screen for the Sentinel RMS License Manager is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard >

Welcome to the InstallShield Wizard for
Sentinel RMS License Manager

The Installshield(R) Wizard will install Sentinel RMS License
Manager on your computer. To continue, didk Next. Itis
recommended that before continuing the installation, the
previous version(g) are uninstalled, incaze they are not used,

WARNING: This program is protected by copyright law and
international treaties.

e Conce
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10. Click Next.

The License Agreement screen for the Sentinel RMS License Manager wizard is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

SOFTWARE LICENSE AGREEMENT

SAFENET RMS, SAFENET SENTINEL CLOUD LICENSING ADD-ON FOR RM5

and SENTINEL RMS ENVELOPE

IMPORTANT INFORMATION - PLEASE READ THIS AGREEMENT CAREFULLY
BEFORE INSTALLING OR USING THE SOFTWARE (as defined herein). The
“Software” means The “Sentinel/® RMS”, “Sentinel® Cloud Licensing Add-
On for RMS" and “Sentinel® RMS Envelope” supplied to you by SafeNet, .,

@I accept the terms in the license agreement Print

()1 do not accept the terms in the license agreement

Installshield

= cores

11. Click the I Accept option and then click Next to continue.

The Customer Information dialog box is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard

Customer Information

Please enter your information.

User Mame:
dimir]
Organization:

[MyCompan]

Install this application for:
() Anyone wha uses this computer (all users)
(®) Only for me (admin)

Instalishield

= ==

12. Click Next to accept the defaults and continue.
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The Destination Folder screen is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard

Destination Folder

Click Next to continue installing to the following folder,
or dick Change to install to a different folder.

D Install Sentinel RMS License Manager to:

C:\Program Files (x86)\Comman Files\SafeMet Sentinel\Sentine! Change...
RMS License Manager',

Instalshield

13. Click Next to accept the default and continue.

The Setup Type screen is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard

Setup Type
Choose the setup type that best suits your needs.

Please select a setup type.

(®) Complete
All program features will be installed. (Requires the most disk
space.)

O Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

= =

14. Click Next to accept Complete (recommended) and continue.
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The System Firewall Settings screen is displayed. Do not clear the check box; it must remain selected so
that the Sentinel RMS Floating License Manager can add inbound rules for the executable (Iservnt.exe).
If you clear this setting CODE V will not be able to obtain the license needed to run.

ﬁ Sentinel RMS License Manager - InstallShield Wizard X

System Firewall Settings Need To Be Modified

The setup program will install the Sentinel RMS License
Manager ({license server) on this system. To allow
communication between the RMS License Manager and the
dients running licensed applications, the system firewall
settings need to be modified. The Sentinel RMS License
Manager will be added to the firewall blodking exceptions
list,

Keep the checkbox below selected to unblock the
firewall. Clearing this chedkox will let the firewall
block the communication between the dients and the
RMS License Manager.

Unblock the system firewall for the Sentinel RMS
License Manaaqer

Tip: For instructions on unblocking the firewall later,
refer to the Sentinel RMS SDK System Administrator's
Help.

15. Click Next.
The Ready to Install screen is displayed.

ﬁ Sentinel RMS License Manager - InstallShield Wizard >

Ready to Install the Program 1 7 I
The wizard is ready to perform selected operation. II

Click Install to begin the installation.

If you want to review or change any of your installation settings, didk Back. Click Cancel to
exit the wizard.

Instalishield

< Back Install Cancel

16. Click Install.

The progress screen is displayed while the software is installed.
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When the installation is finished, the Completed screen for the Sentinel License Manager is displayed.

License Manager

gemalto

ﬁ Sentinel RMS License Manager - InstallShield Wizard X

‘ InstallShield Wizard Completed

1 The InstaliShield Wizard has successfully installed Sentinel RMS

. Click Finish to exit the wizard.

< Back

17. Click Finish.

The Completed screen for the OSG Floating License Manager Admin Tools is displayed.

ﬁ 056 Fleating License Manager Admin Tools

InstallShield Wizard *

InstallsShield Wizard Completed

The InstallShield Wizard has successfully installed 056G Floating
License Manager Admin Tools. . Click Finish to exit the

wizard,

< Back

18. Click Finish.

The installation is complete.

19. Reboot your computer if prompted to do so.

If you already have a CODE V license key file, skip to Installing the License Key for a Floating License
on page 27. If you do not yet have a license key file, continue with Obtaining the Host ID for a License
Dongle on the License Server on page 26.
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Obtaining the Host ID for a License Dongle on the License Server

A license key is designed to work for only one USB dongle, so the license key is associated with a unique
value encoded on the dongle called a Host ID. Before you can request a license key you must know the
Host ID for the license dongle. The Host ID is printed on a label on the USB dongle. You can also obtain the
Host ID by running GetHostID, which reads it from the dongle. If you need to provide your Host ID to
CODE V Support or Sales, the recommended method is to use GetHostID to generate a file that you can

send.

1. Insert the USB dongle in a USB port on the license server. The beacon on the dongle should be

illuminated. If not, try connecting it to a different USB port.

2. Click the Windows Start button and then select OSG Floating License Manager > GetHostID.
In the following figure, the GetHostID utility displays two lines under the Read Dongle Host ID button,

which indicates that two USB dongles are active on this computer.

Dongle Host IDs

‘T GetHostlD Version

Dongle Host 1D

Fiead the Host ID from a USE dongle. Be sure that the dongle
and the dongle device driver are properly installed before uzing
thiz option. Click the Read Dongle Host ID button if the Host 1D
iz not dizplayed below.

Fiead Dongle Host 1D

400-13KMPULPPGI57FM

801w 3ELIRRSTENESGR

Host ID File

Create a file with a complete zet of Host 1Dz for this computer.
Uze thiz option only if requested by Customer Support.

C:AUszershPublichDesktophHost D s bt _

“wiite Host [D File

Hardware Host (D
C14G219GIK2RWGEES

Done

If the box is empty, click the Read Dongle Host ID button.
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To create a HostIDs text file that you can send to CODE V Support or Sales, click Write Host ID File
and then click OK. (If you cannot send the Host IDs file, open the file, copy the contents of the file and
paste it into an email message that you send to CODE V Support or Sales.)

To copy the Dongle Host ID, select the Host ID, right-click and then click Copy. You can then paste the
Host ID into your desired destination.

Click Done to close the GetHostID utility.

Continue with “Retrieving License Keys” on page 58 for instructions on retrieving your license key file
from the Synopsys SolvNetPlus website. After you have your license key, go to “Installing the License
Key for a Floating License” on page 27.

Installing the License Key for a Floating License

After you install the license server software and retrieve a license key, you need to install the license key on
the license server before client machines can successfully run CODE V. The Floating License Installer is
provided for this purpose.

This procedure assumes that you have already obtained a valid CODE V license.dat file from the
SolvNetPlus SmartKeys web page or from your local distributor. To retrieve the file from SolvNetPlus, see
“Retrieving License Keys” on page 58 for instructions.

Follow these steps to install your license key file.

1.
2.

3.

Make sure that the license dongle is inserted in an active USB port on the license server.

Click the Windows Start button and select OSG Floating License Manager > Floating License
Installer.

The Floating License Installer is displayed, as shown in the following figure.

] Floating License Installer, Version b4

Install Floating License File

Install

Click the Browse button D .
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4. In the Open dialog box, navigate to the license key file, select it, and click Open.

The Open dialog box is closed, and the path to the license key file is shown in the Floating License
Installer.

= Floating License Installer, Version

Install Floating License File

C:\Usersusername\Desktoplicense. dat

Install

5. Click the Install button.

The license key file is installed, and the Success dialog box is displayed.

= Floating License Installer, Version

Install Floating License File

C:\Usersusername\Desktoplicense. dat

Install

{ License Installation successful )

6. To close the Floating License Installer, click the X in the top right corner.

Continue with “Installing CODE V on Client Machines” on page 28.

Installing CODE V on Client Machines

CODE V must be installed on each client machine where it will be used. During the installation, choose
Floating License as the license type, and enter the name of the license manager in the Server Hostname
field.

These instructions assume that you have already obtained CODE V from SolvNetPlus or your local
distributor.

1. Log on to your computer as Administrator.
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2. Navigate to the folder that contains the CODE V installation package.
3. Double-click the file CODEVversion.exe.
where version is the version number for the release.

— Ifa User Account Control dialog box is displayed with the message Do you want to allow this app
to make changes to your PC?, click Yes to continue.

The installation files are extracted, and then the Welcome to the InstallShield Wizard page is displayed.
4. Click Next to continue to the License Agreement page.
5. Ifyou accept the agreement, click Yes to continue to the Choose Destination Location page.
6. To accept the default location for the program, click Next.
The Choose Working Folder page is displayed. The working folder is used to store your user files.
7. To accept the default location for the working folder, click Next.

—  Ifyou previously installed CODE V you will be prompted to confirm whether to use the existing
directory. Click Yes to accept and continue to the License Installation Options page.

—  If this is a new installation, you will continue to the License Installation Options page.

8. The License Installations Options page informs you that CODE V Legacy Licensing will be used. Click
Next.

9. When asked to choose the type of license to use, be sure to select the Floating (Network) License
option.

10. Next to the Server Hostname or IPv4 Address option, enter the name or the IPv4 address for the
computer on which the license manager was installed and click Next to continue. In the following
figure, the name OpticServer is used as an example; be sure to enter the name of your license server.

License Installation Options @
Fleaze choose the type of CODE ¥ licenze that will be used:
_ Fixed Licenze

@ Floating [Metwork] License

Server hostname or
|Pv4 address: MyServer] J

11. When the installation is complete, click Finish to close the wizard.

Changing Floating License Options on Client Machines

If you have already installed CODE V to a client machine and then want to switch from a fixed to floating
license or change license servers, refer to “Modifying Legacy License Options” on page 16 to see how to
modify license options on a client machine.

For example, in step 7 of that procedure you can change the floating license server hostname or IPv4 address
to make a correction or to point the client machine to a different floating license server.
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Managing Floating Licenses

In general, there is nothing that you need to do to administrate floating licenses. As long as the license server
machine is operational, connected to the network, and is running the Sentinel service, licenses are available
to clients.

Monitoring License Use
It is possible for all available licenses to be in use, which would prevent additional clients from running

CODE V. In such cases, a system administrator can use the WImAdmin utility to determine to whom the
module licenses have been allocated.

Note: To use the WImAdmin utility, either you must be the person who started the license server, or you
must have administrator privileges.

1. To start the utility from the Windows Start menu, select OSG Floating License Manager >
Administrator Utility.

2. Expand the list of modules below the license server hostname.

The details presented in the dialog box indicate which client machine and username have checked out the

licenses.
£ WimAdmin o] 2 |
File Edit View Tools Help
% Defined Servers Server information
= 5@ Subnet Servers ¥ ﬁ o 5
= int . L 3
[]-- b.internal.synopsys.com =me NLEmELHMopsys.com srsen
-] CODE_V ORA IP address: |192.0.2.0
E@ Licenses Feature information
- W Name CODE V Version: ORA
L Licl Sttt
[]-- cinternal.synopsys.com istics
[]--jmtemal SYNOpsys.com Dz Total ol
=" SINOREYE. Total users 1] 2 1]
[ kinternal.synopsys.com
[ Linternal.synopsys.com Reserved o o
[]-- n.internal.synopsys.com Commuter: i} 2
[]-% Standalone Capacity: 0 0
Redundant: Mo Number of servers: 1 Majority: Ner
Detailed information
Feature Info  License Info | Ciert Info
License type Normal license Start date: Fri Nov 07 00:00:00 2013
License state Active End date: Sat Dec 26 23:55:55 2020
Alowed on VM: Yes

You can also use the WImAdmin utility to obtain other licensing activity information, such as license servers
detected and details on active licenses. For more information about how to use the WImAdmin utility, see
the Sentinel System Administrator’s Guide. After the Sentinel software is installed, this manual is available
from the Windows Start menu in OSG Floating License Manager > System Administrator’s Guide.

Note: Not all functions described in the Sentinel System Administrator’s Guide are supported by CODE V.

All license manager activity is recorded in the file usage.log, which is located in C:\Windows\SYSWOW64.
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Reserving Availability of CODE V Licenses Using Sentinel License Manager

By default, CODE V licenses are available to anyone on your server on a first-come, first-served basis.
Therefore, you can use CODE V immediately without using the Sentinel License Manager. However, if and
when you want the access to these licenses more finely tuned for your work priorities, you can use Sentinel
License Manager to reserve the number of licenses available to a group (using license fokens) and to allow or
deny access to users who are members of a group.

Before using the Sentinel License Manager, consider how you want to organize your groups, as there are
many ways to do so. Remembering the following points will help you to decide how to organize your
groups:

*  Any license not specifically reserved can be used by anyone on your server.

«  After you create a group, you can specify the status of individual members as /ncluded (access allowed)
or Excluded (access denied).

* A user should be assigned as a member of only one group.

*  You can exclude all members of a group from using licenses by specifying 0 licenses for that group.

If the total number of license tokens reserved exceeds the number of concurrent copies of CODE V for
which you have licenses (as defined in your license file) then the license file number will be used.

For example:

+ To organize by department, enter each department in your organization as a separate group, assign the
appropriate number of license tokens to each group, and designate each group member as Included or
Excluded. You can change this designation on a regular basis as your work priorities change.

+ To organize by priority, create one group for preferred users and one group for everyone else. In the
preferred user group, designate all members as Included and assign as many licenses as you can allow.
For the second group, enter everyone else in the company that may need the software and the remaining
licenses (tokens) and designate which people are Included and which are Excluded. You can then change
these Included and Excluded designations on a regular basis as the work load changes.

After you decide on an arrangement, you can use the Sentinel License Manager to implement it by setting up
a reservation file as follows:

1. On the license manager server, start the license manager Administration utility from the Windows Start
button, select OSG Floating License Manager > Administrator Utility.

2. From the menu at the top of the WimAdmin window, choose Edit > Reservation File. to open the
Wilsgrmgr window.

3. Choose File > New to set up a new reservation file. (To modify an existing reservation file, choose File
> Open and then select the Isreserv file in the directory where License Manager is installed.)

4. Choose Feature > Add. The Add License Reservation Wizard opens. Click Next to continue. The
Feature Version window opens.

5. For Feature Name, enter CODE_V (upper case CODE, underscore, upper case V).
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Feature Version Capacity @

Identify an Existing License.
Erter Feature Name, Feature Version {optional) and Capacity (optional).

Feature Name CODE_V

Feature Version ORA

Capacty I No limit
< Back Neat > Cancel |

6. For Feature Version, enter ORA (upper case).
7. Click Next to open the Group window.
8. Follow these steps to establish a user group:

a. Enter a name of your choosing that identifies the user group for whom you want to allow or deny
access. The name cannot exceed 64 characters.

Group @

Add a group for the specified non-capacity feature.
Erter the group name and number of tokens to be reserved for the group

Group Mame Devl
Tokens 1 3:

< Back Neat > Cancel | |

b. Inthe Tokens field, enter the number of licenses to reserve for that group.

c. Click Next to open the Members window.
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9. Follow these steps to add members to the group. Add members who will be allowed access, as well as
members who will be denied access.

a. Click the Add button.

Members @

Add members to the group.
To add a member Press the Add button

Member Name Type Status

Add... | | Remove All | |

< Back | Finish | Cancel | |

b. Inthe Name of Member field, enter the member’s network user name. The name cannot exceed 64
characters. (Note that for CODE V, members can be defined only by user name.)

Member @
Mame of the Member.  |JGrant

Members of a group can either be Users or Machines.
This member iz a:

* User
" Machine
Members can be allowed to run the application by Including them

Or can be prevented to run the application by excluding them.
This member iz :

* Included
" Excluded

()8 | Cancel

c. Select User.

d. Click Included for members who are allowed access and Excluded for members who are denied
access.

e. Click OK.

f.  Repeat the process to add each user in the group.
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g. Click Finish on the Members window, to apply the changes and close the window.

Members @

Add members to the group.
To add a member Press the Add button

Member Name Type Status
JGrant User Included
43 4-1ABIC Machine Included

Add... | | Remove All | |

< Back | Finish | Cancel | |
o ——

10. In the Wisgrmgr window, to add an additional:
a. group and its members, select Group > Add and repeat steps 7, 8 and 9.
b. member to an existing group, double click the group name, click the Members tab and repeat step 9.

11. When you are finished, select File > Save As and navigate to the directory where the license manager is
installed.

By default, license manager is installed in:
C:\Program Files (x86)\Common Files\SafeNetSentinel\Sentinel RMS License Manager\WinNT

12. Keep the default file name, /sreserv, and then click Save. The License Manager references this file to
determine which users have access to each feature.

13. Close the Wisgrmgr window and then close the WimAdmin window.
14. Restart the Sentinel RMS License Manager, as follows.

a. Search for Control and then select System Security

a. Select Administrative Tools and then Services.

b. Locate and right-click the Sentinel RMS License Manager in the list of services and select the
Restart option from the pop-up menu.
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Logging Floating License Usage

Floating license usage is automatically recorded in the file usage.log. The following example shows how
information is formated in this file.

j usage.log - Notepad

File Edit Format View Help

# Startup Sentinel RMS License Manager v8.6.1.0021 Tue May 08 12:24:27 2018 1525807467 PCName1 0 4844

# Shutdown Sentinel RMS License Manager v8.6.1.0021 Tue May 08 12:26:01 2018 1525807561 PCName1 4844 M2
# Startup Sentinel RMS Lir -~ -- Manager v8.6.1.0021 Tue p*---"0% 12-77-nn "nan AEAESO75M™ ™ Name* * "1168

# Shutdown Sentinel RMS se Manager v8.6.1.0021 Sz 2 12 345 6 618 'CNa D168 M,
# Startup Sentinel RMS Li¢ vianager v8.6.1.0021 Sat b 21: 872t lame 52

2 0 NDASMA= ed May 16 12:11:04 2018 152649?860&1\@} ﬁmserName IPCName 1)8.6.1.002 D1 - -
2 0 NDASMA== Wed May 16 12:15:55 2018 1526498155 CODE_V vORA 0 1 0 UserName1 PCName1 8.6.1.0021 1 -

2 0 NDASMA== Wed May 16 12:17:00 2018 1526498220 CODE_V vORA 2 0 65 UserName1 PCName1 8.6.1.0021 1 -
2 0 NDASMA==Wed May 16 12:17:08 2018 1526498228 LTCore vORA 2 0 364 UserName1 PCName1 8.6.1.0021 1 -

As shown in the highlighted portions, the entries include:

1 - day, date, and time stamp

2 - the product or module

3 - a code that indicates whether the license was issued (0), denied (1), or released (2)

4 - the number of floating licenses in use after the current release or request.

5 - elapsed time the license was in use (in seconds). This value is 0 until the license is released.
6 - the user ID

7 - the host name

8 - the version number for the floating license manager

By default, the usage.log file is located in the folder C:\Windows\SYSWOW64. You can change the location
and name of the file, if desired, as described in the following steps.

1. Inthe Windows search box, type “edit environment” and select Edit environment variables for your
account (or similar search result for your Windows version).
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2. In the Environmental Variables dialog box, select LSERVOPTS and click Edit.

Environment Variables *

User variables for ktorima

Variable Value

OneDrive ChUsers)) -
OneDriveCommercial ChlUsersy WOneDrive -1 Inc
Path Ch\Usersy, \AppData\Local\Microsaft\WindowsApps;
TEMP Ch\Usersy| ‘AppDataiLocal\Temp
TMP ChUsersy ‘AppDataiLocal\Temp
MNew... Edit... Delete

Systemn variables

Variable Value L

ComSpec CAWINDOWS\system32\cmd.exe

CYGWIN nodosfilewarning

DriverData C:AWindows\System32\Drivers\DriverData

I_MPI_ROOT CA\Program Files (x86)\IntelSWTools\compilers_and_libraries_2018....

INTEL_LICENSE FILE CA\Program Files (x86)\Common Files\Intel\Licenses

LSERVOPTS -l ch\templusage.log -z 20m -f c\temp'errorlog

NUMBER_OI_PROCESSORS 4

OPTSIM_PDAFLOW_PDK_RO... C\Synopsys\PhotonicSeolutions)2023.03\OptoDesigner v
New. Delete

Cancel

By default, the value for LSERVOPTS is
-1 usage.log -z 20m -f error.log

3. Inthe Edit System Variable dialog box, change the path and/or file name by replacing the string
usage . log with the desired path and file name. In the following example, the new path for the file is
C:\temp\usage. log.

Edit System Variable *

Variable name: LSERVOPTS
‘Atemphusage.log [z 20m -f citemp\error.log
Browse Directory... Browse File... OK Cancel

Variable value:
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4. Restart the license manager in the services list, as described in the following steps.

The change takes effect after the license manager is restarted.
a. Inthe Windows search box, type “services” and select the Services app.
b. Inthe Services dialog box, locate and select the Sentinel RMS License Manager and then click

Restart the Service.

o Services - O *
File Action View Help
| EHEG= HEI >»®n»
. Services (Local) || <) Services (Local)
Sentinel RMS License Manager MName Description L
Sentinel RMS License Manager = Sentinel RMS License Manager
Stop the service - - N
Pauce the service i Server Supports file, Frlnt, and named-p...
W &k Shared PC Account Manager  Manages profiles and accounts o...
Q;Shell Hardware Detection Provides notifications for AutoPl...
o Q;SmartCard Manages access to smart cards r...
Desc”ptlon: L Sy N o ST SR AU . I S R 2
Sentinel RMS License Manager < >

\ Extended /(Standard /

For additional information about the usage log, See the Sentinel System Administrator’s Guide. After the
license manager software is installed, this manual is available by selecting the Windows Start menu and
selecting Programs > OSG Floating License Manager > System Administrator’s Guide.
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Nodelocked License

With Synopsys Common Licensing, you can run CODE V using either a nodelocked license or a network
license. This chapter describes how to install the product to run using a nodelocked license, which allows
you to run CODE V only on the computer on which it is installed. With this license, you can open up to eight
concurrent CODE V sessions.

What You Need for Nodelocked License Installation

You will need the following items to install CODE V with a nodelocked-license:

* CODE V - You need a copy of CODE V installation file (either downloaded from the Synopsys
SolvNetPlus website or received from your local distributor) or on a CODE V DVD (that you ordered
and received from SolvNetPlus or from your local distributor).

* License Key — a license key that corresponds to your CODE V license and to a Host ID. The Host ID
may be associated with your computer’s hardware or with a USB dongle attached to a port on your
computer.

For details, see Appendix A, “Using SolvNetPlus to Obtain CODE V Software and Licenses” on page 51.

Note: For customers working with distributors, please contact your local CODE V software
distributor to obtain your software and license. See the Synopsys Optical Solutions Group Global
Contacts page for contact information.

You may also need a USB dongle acquired by you or your site’s license administrator from your local
Synopsys Sales Representative. Your CODE V or IT Administrator should inform you if one is required. If
you are the CODE V or IT Administrator, contact your CODE V representative. If you control your licensing
with this method, you also must have a:

+  USB dongle (the dongle comes with a label that shows its Host ID)
«  USB2.0 (or higher) port (for Type A) into which you can plug the dongle
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Installing CODE V with a Nodelocked License
These instructions assume that you have already have the items described in What You Need for Nodelocked
License Installation on page 39. If your site uses a dongle, it should be plugged into your machine.
1. Log on to your computer as Administrator.
2. Navigate to the folder that contains the CODE V installation package.
3. Double-click the file CODEVversion.exe.
where version is the version number for the release.

— Ifa User Account Control dialog box is displayed with the message Do you want to allow this app
to make changes to your PC?, click Yes to continue.

The installation files are extracted, and then the Welcome to the InstallShield Wizard page is displayed.
4. Click Next to continue to the License Agreement page.
5. Ifyou accept the agreement, click Yes to continue to the Choose Destination Location page.
6. To accept the default location for the program, click Next.
The Choose Working Folder page is displayed. The working folder is used to store your user files.
7. To accept the default location for the working folder, click Next.

— Ifyou previously installed CODE V you will be prompted to confirm whether to use the existing
directory. Click Yes to accept and continue to the License Installation Options page.

— If'this is a new installation, you will continue to the License Installation Options page.
8. Click the check box next to My license is for Synopsys Common Licensing and click Next.
9. Select Nodelocked and click Next to continue to the License Key File Setup page.
10. Do one of the following:

— Ifyou already have a license key for this product, enter the full path and file name or click the
Browse button, navigate to the file, select it and click Open. Click Next to continue.

— Ifyou do not yet have a license key, you can install it later. Leave the location blank and click Next.
When you’re ready to get your license key file, see Obtaining the Host ID for an SCL Nodelocked
License on page 41 and Installing a License Key File for an SCL Nodelocked License on page 42.

11. If the Preparing to Install page is displayed, select Do not close the applications and then click Next to
continue.

12. In the Start Copying Files page, confirm your information.
— If the information is correct, click Next.

— Ifacorrection is needed, use the Back and Next buttons to navigate between pages. Make your
corrections and then return to this page before clicking Next.

13. When the installation is complete, click Finish to close the wizard.
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Obtaining the Host ID for an SCL Nodelocked License

A license key is associated with a unique value on your device called a Host ID, and it works for only one
computer or USB dongle. Because of this, you need to know the Host ID for your computer or dongle before
you can retrieve a license key file.

Obtaining the Host ID for a Computer
If you are not using a dongle, you can use the Imhostid utility installed with Synopsys Common Licensing to

obtain the Host ID for your computer. Follow these steps to run the Imhostid utility.

1. Click the Windows Start button and select Synopsys SCL > Imhostid 2022.12.

Ggj FLEXidCleanUtility 202212
| FLEXIdInstaller 2022.12
= New

! Imhostid 2

2. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See Retrieving
License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key File for an SCL Nodelocked License on
page 42.

Obtaining the Host ID for a Dongle

If you are using a dongle for Synopsys Common Licensing, follow these steps to obtain the Host ID for the
dongle.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s inserted
correctly in an active USB port.

2. From a command prompt, navigate to C:\Synopsys\SCL\2022.12\win32\bin.
3. Enter the command 1lmhostid -flexid

The following example shows a single Host ID, but the command may return multiple values
(depending on your machine). You can use any single value.
C:\Synopsys\SCL\2022.12\win32\bin>1mhostid -flexid
Imhostid - Copyright (c) 1989-2022 Flexera. All Rights Reserved.
The FlexNet host ID of this machine is "FLEXID=10-3abcdcba"
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4. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See Retrieving
License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key File for an SCL Nodelocked License on
page 42.

Installing a License Key File for an SCL Nodelocked License

If you didn’t have or specify the location for your license key file when you installed CODE V, you can
follow these steps to install it.

This procedure assumes that you have already obtained a valid license key file from the SolvNetPlus
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for instructions.

Follow these steps to install your license key file.

1. Ifyou are using a dongle for Synopsys Common Licensing, insert the USB dongle in an active USB
port. A light glows at the end of the dongle when it’s inserted correctly in an active USB port.

2. Start the wizard to configure licensing in either of the following ways:

—  Click the Windows Start button and select CODE V 2024.03 > Configure Licensing
(CV2024.03).

—  Start CODE V. When the License Error dialog box is displayed, click the Configure Licensing
button.

The License Type Setup screen is displayed, showing the type of license specified for your computer.
3. Click Next.
The License Key File Setup screen is displayed.

4. Enter the full path and file name or click the Browse button, navigate to the file, and select it the
Windows Open dialog box.

5. Click Next on the License Key File Setup screen.
The SCL Installer Setup screen is displayed.
6. Leave the input field blank and click Next to accept the current version.

When the progress screen closes, the license key file is installed and ready to use.

42 ¢ CODEYV Installation Guide



Chapter 4 Installing CODE V with an SCL Nodelocked License

Modifying License Options for Synopsys Common Licensing Nodelocked
Licenses

Use the Configure Licensing tool to update your SCL license information. You can use it to switch between
SCL license types. For Nodelocked and Network Server license types, you can change the license key files.
For the Network Client license type, you can update the information to communicate with Network Servers.
Follow these steps to change the SCL license information.

1. Click the Windows Start button and select CODE V 2024.03 > Configure Licensing (CV2024.03).
The License Type Setup screen is displayed.

2. Select the option you want and click Next.

3. Based on your selection, do one of the following:

—  For Nodelocked or Network (Server Installation), enter or browse to the license key file and click
Next. On the SCL Installer Setup screen, leave the input field blank an click Next to accept the
current version.

—  For Network (Client Installation), enter the name of the server on the Network Client Setup screen
and click Next.

The licensing option is updated, and the setup wizard is closed.
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Chapter 5 Installing and Managing an SCL
Network License

With Synopsys Common Licensing, you can run CODE V using either a nodelocked license or a
network license. This chapter describes how to install the product to run using a network license on a
network server, which allows you to run CODE V on any computer on the same network and
describes how to install CODE V on one or more client computers.

Each license server makes available a number of CODE V product module licenses with each license
permitting eight concurrent sessions of CODE V to be run. The total number of licenses are
determined by your company’s license agreement. The total number of sessions may be shared across
client computers if enough licenses are available.

For example, if a license server has two licenses available and each license allows up to eight
concurrent CODE V sessions, then one client computer could use eight sessions from the first license
and eight sessions from the second license. If that client computer instead used only three sessions
from the second license, then the remaining five sessions would still be available and could be used by
another client computer.

Synopsys Optical Solutions software products cannot share licenses with each other; they share only
the license server software. A single license server can be used to serve all Synopsys Optical Solutions
products that support SCL Licensing. If you would like to consolidate your license serving needs,
contact your local Synopsys Sales Representative for guidance on procuring licenses.

Note: Installing a network license requires system-administration-level training and should be
performed by someone who is familiar with your network structure. To perform this installation, you
must be logged on as administrator.

The steps for installing CODE V to run with a Synopsys Common Licensing network license are:
1. Selecting a License Server on page 46
. Installing Synopsys Common Licensing on a License Server on page 46
Obtaining the Host ID for an SCL Network License on page 47

2
3
4. Installing a License Key for an SCL License Server on page 48
S. Installing CODE V on Client Machines on page 49

6

. Optional: Modifying License Options for Synopsys Common Licensing Network Licenses on page
50
7. Optional: Managing Network Licenses on page 50
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Selecting a License Server

Before installing any software, you must identify the computer that will act as the license server. This
must be a computer connected to a network through which it can communicate with one or more
client computers.

Note: By default, Synopsys Common Licensing communicates via port 27020, the server port, as well
as 27021, the vendor daemon port. If you will be running CODE V across different subnets, you will
have to configure your routers or firewalls to allow two-way communication across your designated
port.

When specifying the server name for a network client, specify the port and the server name or IP
address. For example, 27020@MyServer or 27020@123.456.78.90.

You can run Synopsys Common Licensing server on the following operating systems: Windows 10,
Windows 11, Windows Server 2016, and Windows Server 2019.

System requirements for a Synopsys Common Licensing server are available here: https://
www.synopsys.com/support/licensing-installation-computeplatforms/licensing/scl-supported-
os.html.

Installing Synopsys Common Licensing on a License Server

The Synopsys Common Licensing installation software is included in the CODE V installer. Follow
these steps to install Synopsys Common Licensing on the computer you have designated as the
license server.

1. Log on to your computer as Administrator.
2. Navigate to the folder that contains the CODE V installation package.
3. Double-click the file CODEVversion.exe.

where version is the version number for the release.

— Ifa User Account Control dialog box is displayed with the message Do you want to allow this
app to make changes to your PC?, click Yes to continue.

The installation files are extracted, and then the Welcome to the InstallShield Wizard page is
displayed.

4. Click Next to continue to the License Agreement page.
5. Ifyou accept the agreement, click Yes to continue to the Choose Destination Location page.
6. To accept the default location for the program, click Next.
The Choose Working Folder page is displayed. The working folder is used to store your user files.
7. To accept the default location for the working folder, click Next.

— Ifyou previously installed CODE V you will be prompted to confirm whether to use the
existing directory. Click Yes to accept and continue to the License Installation Options page.

— If'this is a new installation, you will continue to the License Installation Options page.

8. Click the check box next to My license is for Synopsys Common Licensing and click Next.
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9. Select Network (Server Installation) and click Next to continue to the License Key File Setup
screen.

10. Do one of the following:

— Ifyou already have a license key for this product, enter the full path and file name or click the
Browse button, navigate to the file and select it and click Open. Click Next to continue.

— Ifyou do not yet have a license key, you can install it later. Leave the location blank and click
Next. When you’re ready to get your license key, see Obtaining the Host ID for an SCL
Network License on page 47 and Installing a License Key for an SCL License Server on page
48.

11. If the Preparing to Install page is displayed, select Do not close the applications and then click
Next to continue.

12. In the Start Copying Files page, confirm your information.
— If the information is correct, click Next.

— Ifa correction is needed, use the Back and Next buttons to navigate between pages. Make your
corrections and then return to this page before clicking Next.

13. When the installation is complete, click Finish to close the wizard.

Obtaining the Host ID for an SCL Network License

A license key is associated with a unique value on your device called a Host ID, and it works for only
one computer or USB dongle. Because of this, you need to know the Host ID for your computer or
dongle before you can retrieve a license key file.

Obtaining the Host ID for a Computer

If you are not using a dongle, you can use the Imhostid utility installed with Synopsys Common
Licensing to obtain the Host ID for your computer. Follow these steps to run the Imhostid utility.

1. Click the Windows Start button and select Synopsys SCL > Imhostid 2022.12.

nopsys SCL

g FLEXidCleanUtility 2022.12
N New
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2. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key for an SCL License Server on page
48.

Obtaining the Host ID for a Dongle

If you are using a dongle for Synopsys Common Licensing, follow these steps to obtain the Host ID
for the dongle.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s
inserted correctly in an active USB port.

2. From a command prompt, navigate to C:\Synopsys\SCL\2022.12\win32\bin.
3. Enter the command 1lmhostid -flexid

The following example shows a single Host ID, but the command may return multiple values
(depending on your machine). You can use any single value.

C:\Synopsys\SCL\2022.12\win32\bin>1lmhostid -flexid
Imhostid - Copyright (c) 1989-2022 Flexera. All Rights Reserved.
The FlexNet host ID of this machine is "FLEXID=10-3abc4dcba"

4. Copy the Host ID to retrieve your license key on the Synopsys SolvNetPlus website. See
Retrieving License Keys on page 58 for instructions.

After you retrieve your license key, go to Installing a License Key for an SCL License Server on page
48.

Installing a License Key for an SCL License Server

If you didn’t have or specify the location for your license key file when you installed CODE V, you
can follow these steps to install it.

This procedure assumes that you have already obtained a valid license key file from the SolvNetPlus
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for
instructions.

Follow these steps to install your license key file.

1. If you are using a dongle for Synopsys Common Licensing, insert the USB dongle in an active
USB port. A light glows at the end of the dongle when it’s inserted correctly in an active USB
port.

2. Start the wizard to configure licensing in either of the following ways:

— Click the Windows Start button and select CODE V 2024.03 > Configure Licensing
(CV2024.03).

— Start CODE V. When the License Error dialog box is displayed, click the Configure
Licensing button.

The License Type Setup screen is displayed, showing the type of license specified for your
computer.

3. Click Next.
The License Key File Setup screen is displayed.
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Enter the full path and file name or click the Browse button, navigate to the file, and select it the
Windows Open dialog box.

Click Next on the License Key File Setup screen.
The SCL Installer Setup screen is displayed.
Leave the input field blank and click Next to accept the current version.

When the progress screen closes, the license key file is installed and ready to use.

Installing CODE V on Client Machines

CODE V must be installed on each client machine where it will be used. During the installation, you
select Network (Client) as the license type and then specify the name of the server, which is the
computer on which the license manager is installed.

With this license type, the licenses are installed and managed by an Synopsys Common Licensing
server. You need the Synopsys Common Licensing server host name and the port used by your
organization. This should be provided by your CODE V or IT administrator.

These instructions assume that you have already downloaded CODE V from the Synopsys
SolvNetPlus website via electronic software transfer (EST) or that you ordered and received a
CODE V DVD. If you have not done so, see Using SolvNetPlus to Obtain CODE V Software and
Licenses on page 51.

1.
2.
3.

10.

Log on to your computer as Administrator.

Navigate to the folder that contains the CODE V installation package.
Double-click the file CODEVversion.exe.

where version is the version number for the release.

— Ifa User Account Control dialog box is displayed with the message Do you want to allow this
app to make changes to your PC?, click Yes to continue.

The installation files are extracted, and then the Welcome to the InstallShield Wizard page is
displayed.

Click Next to continue to the License Agreement page.

If you accept the agreement, click Yes to continue to the Choose Destination Location page.

To accept the default location for the program, click Next.

The Choose Working Folder page is displayed. The working folder is used to store your user files.
To accept the default location for the working folder, click Next.

— If you previously installed CODE V you will be prompted to confirm whether to use the
existing directory. Click Yes to accept and continue to the License Installation Options page.

— If this is a new installation, you will continue to the License Installation Options page.
Click the box next to My license is for Synopsys Common Licensing and click Next.
Select the Network (Client Installation) option.

On the Network Client Setup screen, enter the name of the port and the computer on which the
Synopsys Common Licensing Network (Server Installation) software is installed. For example,
27020@MyServer where 27020 is the port and MyServer is the server name.
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If you want to enter more than one server name, separate the names with a semicolon. For
example, 27020@MyServerl; 27020@MyServer2 where MyServerl and MyServer?2
are the two servers used. Synopsys Common Licensing checks the servers in the order listed.

When the progress screen closes, the Synopsys Common Licensing software installation is
complete.

11. In the Start Copying Files page, confirm your information.
— If the information is correct, click Next.

— Ifacorrection is needed, use the Back and Next buttons to navigate between pages. Make your
corrections and then return to this page before clicking Next.

12. When the installation is complete, click Finish to close the wizard.

Modifying License Options for Synopsys Common Licensing Network Licenses

Use the Configure Licensing tool to update your SCL license information. You can use it to switch
between SCL license types. For Nodelocked and Network Server license types, you can change the
license key files. For the Network Client license type, you can update the information to communicate
with Network Servers. Follow these steps to change the SCL license information.

1. Click the Windows Start button and select CODE V 2024.03 > Configure Licensing
(Cv2024.03).

The License Type Setup screen is displayed.
2. Select the option you want and click Next.
3. Based on your selection, do one of the following:

— For Nodelocked or Network (Server Installation), enter or browse to the license key file and
click Next. On the SCL Installer Setup screen, leave the input field blank an click Next to
accept the current version.

— For Network (Client Installation), enter the name of the server on the Network Client Setup
screen and click Next.

The licensing option is updated, and the setup wizard is closed.

Managing Network Licenses

In general, there is nothing that you need to do to manage the network licenses. As long as the
network license server machine is operational, connected to the network, and is running the Synopsys
Common Licensing (SCL) service, licenses are available to clients.

Synopsys Common Licensing provides tools that enable you to fine tune how your licenses and
sessions are distributed using Options files. For information about using Options Files, see
“Managing the Options File” in the FlexNet Publisher License Administration Guide, available on
SolvNetPlus.
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Appendix A Using SolvNetPlus to Obtain
CODE V Software and Licenses

Software and license keys for CODE V are available for download from the Synopsys SolvNetPlus
website. This appendix describes how to use the website to download this software products and the
license keys required to use it.

Note: For customers working with distributors, please contact your local CODE V software
distributor to obtain your software and license. See the Synopsys Optical Solutions Group Global
Contacts page for contact information.

Special terms used in these instructions are explained in Glossary on page 67.

The process is described in the following procedures.

1. Signing Up for a SolvNetPlus Account on page 52

2. Downloading CODE V Software from SolvNetPlus on page 53
or
Ordering Media (CDs/DVDs) on page 56

3. Installing CODE V on page 57

4. Obtaining the Host ID on page 58

5. Retrieving License Keys on page 58
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Signing Up for a SolvNetPlus Account

Before you can download CODE V software and license keys, you must sign up for a Synopsys

SolvNetPlus account. If you already have a SolvNetPlus account, you can skip to Downloading
CODE V Software from SolvNetPlus on page 53.

1. Go to https://solvnetplus.synopsys.com and click REGISTER - CREATE ACCOUNT.

. SYNOPSYS.COM | REGISTRATIONHELP | #8h | EHgh | ~r7
SYNopPsys

SolvNetPlus

SignIn

Need help signing in?

I REGISTER - CREATE ACCOUNT I FORGOT PASSWORD

©2022

~

Synopsys, Inc. 58 All Rights Reserved. | FICPEH09052939 SIGN IN SUPPORT | TERMSOFUSE | PRIVACY POLICY

2. Follow the instructions for self registration.

SolvNetPlus will send a verification code to the email address you specified. You must provide
this code to continue with registration.

During the registration process, you will need to enter your company’s Site ID. If you do not know

your company’s Site ID, please contact solvnetplusfeedback@synopsys.com to request it. Be sure
to include your company name and address in the email request.
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Downloading CODE V Software from SolvNetPlus

Follow these steps to download the CODE V product. If you unable to download software, you can
order a CD or DVD instead. See Ordering Media (CDs/DVDs) on page 56 for instructions.

1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in.

2. In SolvNetPlus, click Downloads.

Downloads

All Synopsys products currently licensed at your company will be listed.

3. Select the product that you want to download.

HOME » DOWNLOADS

My Product Releases | LV SV LR

My Product Releases

New! indicates new release within past 45 days.

CODE V new!

4. Select the version you would like to download.
HOME # DOWNLDADS

My Product Releases | i =0 4 LR

CODE V
Choose your version number from the list below.
2024.03 NEW!
2023.03a
2022.03-1
2022.03
11.5-1
11.5
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The Download Details page is displayed. From this page you may download the latest Release
Notes, Installation Guide, and the installation software package. If you have not signed up to
receive release alerts, it is recommended that you do so.

HOME » DOWNLOADS

ty Product Rleases

Download Details: CODE V: 2024.03

| Download Here | FTPS Download EFTStream Download
SFTP Download

RELEASE ALERTS ¥
£ Sign up for CODE V

RELEASE NOTES
# View release notes

INSTALLATTION GUIDE

5. In Download Details under Release Alerts, click the Sign up link to display Release Alerts
options that allow you to subscribe to Release Notification emails from SolvNetPlus. These
emails let you know when a new version of CODE V is available for download.

Release Alerts

To be notified of new releases for your authorized product(s), select from the product list below. Check the
"include patch" box to receive patch updates. Notifications will be sent to your registered SolviMet email
address.

Available Products Products Selected

- LightTools -
LucidShape CAA V5 Basad
[ ] ALL

Include patch notifications (for all products)

Reset

®

Click the product name for which you would like to receive notifications or click ALL to
receive notifications for all products in the list.

. Click the Add button.

Click the Include patch notifications check box. This allows you to receive notifications of
CODE V service releases.

d. Click the Update button.

You are returned to the Download Details page.

o

°©
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On the Downloads Details page, click Download Here to download from your browser or read
and follow the instructions for the other download choices.

On the Notice page, read the notice and then click Agree and Sign In to continue.

From the list of available files, click the name of the file and then use your browser to open or save
the file.

Syn Upsysg « Uploads: Upload files under MyFolders > Incoming (If File > 2GB, use SETP or FTPS)

Downloads: Access to files are given during SolvNetPlus login. If the files are not available, logout and login again.
« The checkbox function may not get the download quantity you expect, please click the file directly.

' MyFolders... / rev / cv_v2024.03

~ @@ My Folders

B Incoming

Libraries

metadata

MyProducts

(=T N oS

Fs
[ ] O Name a

O D checksum_info.txt
O D CODEV exe
O D FloatingLM exe

The following files are available for CODE V. Based on the version of CODE V that you select in
step 4, the actual file names displayed may be different but will have similar names.

— checksum_info.txt is a file used for internal purposes.

— CODEVversion.exe (where version is the version number for the release) is the installation file
for CODE V.

— FloatingL.Mversion.exe is for customers using CODE V Legacy licensing with a floating
license. Only the system administrator who will set up a floating license server needs to
download this file. See Installing CODE V with a Floating License (Legacy Licensing) on page
17 for installation instructions.

Next steps:

If you need to obtain a license key, see Retrieving License Keys on page 58.

If you already have a license key, see one of the following procedures, based on the licensing you
are using:

Installing CODE V with Legacy Licensing on page 11

Installing CODE V with a Floating License (Legacy Licensing) on page 17.
Installing CODE V with a Nodelocked License on page 40

Installing and Managing an SCL Network License on page 45
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Ordering Media (CDs/DVDs)

If you unable to download software and would like to order media (CD or DVD) instead, you can do
this directly on the Synopsys SolvNetPlus website. Follow these steps to order media.

1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in.
2. Click the Downloads tile.
3. In the lower-right area of the page, click the MediaCenter link.

DOCUMENTATION
DOWMNLOADS FAQ
RELEASE NOTIFICATIONS
MEDIACENTER
LICENSING
INSTALLATION

SUPPORTED PLATFORMS

SMARTKEYS

4. Onthe Media Center page, select the product (e.g., CODE V, LightTools, etc.) and click the Add
button.

HOME » DOWMLOADS

Instructions:
Tangible media with the latest production version will be shipped.

Only products on current support are available to order. Orders will be shipped within four business days to the address
below.

Select product(s) from the left list and add to right list to request tangible media.

User: -

Available Preducts Products Selected
CODE VY

5. Complete the Shipping Address information and click Continue.
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6. Review the shipping request, shown in the following figure, and click Place Order.

HOME » DOWNLOADS

Please check the following information. If everything is correct, click "Place Order” button to place the order. Otherwise,
click "Back” button to make correction.

Name Cary Rose

User Name crose

Site ID ioo0

Products 46217-EST LucidShape 2028.06-1
Additional Information

Email CARYROSE@SYNOPSYS.COM
Attention to Name Cary Rose

Job Title

Company Name 1 Synopsys Inc.

Company Name 2
Department 1
Department 2
Department 3
Department 4

Address 1 199 South Los Robles Ave
Address 2 CcA

Address 3

Address 4

Address 5

City Pasadena
Zip/Postal Code 91101
State/Province CA - California
District

Country US - United States
Phone Number 626-696-2101

Is Primary Contact No

Request permanent
change to site addresses

| << Back || Place Order

No

Installing CODE V

Instructions for installing CODE V software and license keys are provided in the following chapters:

Getting Started on page 5 - Explains what you need for installation, lists CODE V system and
licensing requirements and tells you how to contact CODE V Support.

Installing CODE V with Legacy Licensing on page 11 - With a fixed license, you install the
product, the license dongle, and the license key on the computer where you want to run CODE V.

Installing CODE V with a Floating License (Legacy Licensing) on page 17 - With a floating
license, you install the license dongle and license key on a network server and the product on one
or more client machines where you want run CODE V; you also install the OSG Floating License
Manager on the network server to manage the licenses.

Installing CODE V with a Nodelocked License on page 40 - With a nodelocked license, you install
the dongle (if you’re using one), Synopsys Common Licensing software, CODE V product, and
license key file on the computer where you want to run CODE V.

Installing and Managing an SCL Network License on page 45 - With a network license, you install
the dongle (if you’re using one), Synopsys Common Licensing software, and license key file on a
network server and then install the product on one or more client machines where you want run
CODE V.

After you install the CODE V product, continue with Obtaining the Host ID on page 58.
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Obtaining the Host ID

A license key is associated with a unique value on your device called a Host ID, and it works for only
one computer or USB dongle. Because of this, you need to know the Host ID for your computer or
dongle before you can retrieve a license key file. Based on the licensing you’re using, see one the
following procedures.

for CODE V Legacy Licensing:

» Fixed license - Obtaining the Host ID for a License Dongle on page 14

* Floating license - Obtaining the Host ID for a License Dongle on the License Server on page 26
for Synopsys Common Licensing:

» Nodelocked license - Obtaining the Host ID for an SCL Nodelocked License on page 41

» Network (Server) license - Obtaining the Host ID for an SCL Network License on page 47

Retrieving License Keys

A license key is a file associated with your specific computer or USB dongle. The license key file
contains licensing information that allows one or more computers to use Synopsys products. (The
number of computers depends on your licensing agreement and licensing method employed.) You can
obtain a license key using the SmartKeys web page on the Synopsys SolvNetPlus website. Follow
these steps to obtain your license key.

1. On SolvNetPlus Home page, click the Downloads tile, and then click the SmartKeys tab.

SolvNet®
.«
N Documentation Methodology

2. On the SmartKeys Home page, click the Key Retrieval link.

SmartKeys Home Key Retrieval Monthly TSL Key Redemption

Welcome Karen Tori

Key Retrieval

This function enables license key retrieval of unexpired keys for all Host IDs tied to a specific Site ID.

Monthly TSL Key Redemption

This function enables redemption of pre-purchased license "tokens". You must provide your Site ID, Host ID, token start date and
the number of tokens you wish to redeem.

The SmartKeys Key Retrieval page is displayed.

You can retrieve a license key for a single host (your computer or USB dongle), or you can
retrieve license keys for all Host IDs at your company.
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3. To obtain a license key for a single host, enter the Host ID of your computer or CODE V USB
dongle in the Host ID (Optional) field. If you do not know the Host ID value for your USB dongle,
see Obtaining the Host ID on page 58.

To obtain license keys for all products and all Host IDs at your company, leave the Host ID
(Optional) field blank and go on to step 4.

4. Click Retrieve Key, shown in the following figure.

SmartKeys Home Key Retrieval Monthly TSL Key Redemption Links~

Key Retrieval

Site ID - Retrieve keys for site IDs for which you are registered. Multiple site IDs may be selected using the Ctrl or Shift key.
You may register for additional site IDs by updating your SolvNet profile.

Host ID (Optional) - Retrieve a key for a specific host ID. For redundant server configurations, enter only one of the hostids.
CODE V & LightTools Users: Click here for information on obtaining the host ID.

Key Retrieval

Site ID

74674 - Synopsys Optical Resealﬂ *

Site ID (Override)
Host ID (Optional)

Attachment Option

Text Format ﬂ *

Reset

Your CODE V license key will be delivered as a text file attached to an email from the SmartKeys
system. If you did not enter a Host ID in step 3, you will receive a separate email with a single
license key attached for each Host ID at your company. The email will include the Host ID for
which the license key is valid.

5. Save the license key to a convenient location on your computer. You need to access this file to
activate CODE V.
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6. See one of the following procedures for instructions on installing the license key to activate your
CODE V product.

for CODE V Legacy Licensing:

— Fixed license - Installing a License Key File for a Fixed License on page 15

— Floating license - Installing the License Key for a Floating License on page 27

for Synopsys Common Licensing:

— Nodelocked license - Installing a License Key File for an SCL Nodelocked License on page 42

— Network (Server) license - Installing a License Key for an SCL License Server on page 48

60 * CODEV Installation Guide



Appendix B Troubleshooting the CODE V
Legacy Licensing Floating License
Installation

If a security problem occurs when you use a CODE V Legacy Licensing floating license, a License
Manager Error dialog box displays an error message. Below are a few common security errors with their
causes and resolutions. If you are unable to correct the problem, please contact CODE V Support (see
Contacting Customer Support on page 9).

Problem Adding License Keys to the License Server

Problem: Sentinel: Error [19]: Failed to add license code...

Cause: This general error message indicates that the license keys were not applied successfully in the
license manager. This can occur if the file where the keys are being read is corrupted. However,
this error an also occur if license keys that have already been successfully entered are entered a
second time.

Solution:  Verify that the license file contains license keys for the current version of CODE V being
installed, and not for an earlier version (the version number is listed in the comments of the
license file received from Synopsys). Also verify that the license file has not become corrupted.
This might occur if the license file has been edited (that is, lines containing license keys are
changed or become line wrapped incorrectly). When you install a license key, follow the
procedure Installing the License Key for a Floating License on page 27.

Problems Starting CODE V

Problem:  Error #18b - No valid license code for version x.xx found.
Cause: There has not been a valid license key entered for this version of CODE V.

Solution:  See Installing a License Key File for a Fixed License on page 15 for instructions on installing
license keys.
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Problem:

Cause:

Solution:

Problem:
Cause:

Solution:

Problem:

Cause:

Solution:

Cause:
Solution:
Cause:

Solution:

Problem:

Cause:

Error #18b(13) - The Floating License manager is out of date.

The CODE V version running on this computer is not supported by the Floating License
Manager running on the license server specified in File > License Manager on the Info tab in
the License Server box. (To support the latest client version, the administrator must update the
Floating License Manager software on the license server to a version compatible with the latest
CODE V software version running on its licensed clients. See “CODE V System
Requirements™ on page 5 for compatibility information. See “Installing the Floating License
Manager on the License Server” on page 19 for installation instructions.)

Contact the license server administrator to find out when the license server will be updated.
After the license server is updated, restart CODE V. If the license server administrator directs
you to a new license server, see “Changing Floating License Options on Client Machines” on
page 29.

Error #0xC800100D - License code for version x.xx has expired.
The license key for CODE V has expired, or the PC date is before the start date of the license.

Verify that the date on the computer is correct. Install the license key for this version of
CODE V on the license manager machine according to the instructions in Installing the
License Key for a Floating License on page 27. If a new license key is needed, contact
CODE V Customer Service.

Error #8001008 - License manager is not responding. Verify license manager host is
available and license manager process is running.

The Sentinel Floating License Manager program has been disabled.

Restart the license manager program. To do this: On the PC where the license server is
installed, open the Control Panel (select Start > Settings > Control Panel), select
Administrative Tools and then Services. Locate and right-click Sentinel RMS License
Manager in the dialog box, and select the Start option on the pop-up menu.

The license manager machine is unavailable.
Verify that the license manager machine is available on the network.
The ORA_LSHOST environment variable is not set or is incorrectly set.

Check to make sure the license server name is correct by choosing the File > License
Manager menu in CODE V. If the license server name is incorrect, modify it. See “Changing
Floating License Options on Client Machines” on page 29 for information.

An unexpected licensing error has occurred.

An error has occurred with the license manager. The License Manager Error dialog box will
contain more specific information about the problem, which is provided by the Sentinel
Floating License Manager program. If you are still having difficulties identifying the problem,
contact CODE V Support for guidance.
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Appendix C Troubleshooting Synopsys
Common Licensing

This appendix lists licensing errors that you might encounter with Synopsys Common Licensing and
describes probable causes and resolutions. If you are unable to correct the problem, please contact
CODE V Support (see Contacting Customer Support on page 9).

While the CODE V installer streamlines the product installation and the Synopsys Common
Licensing installation, problems may occur. Use the following information to understand error
messages and resolve issues.

The CODE V installer includes the following components for Synopsys Common Licensing:
* Optical/Photonics Solutions Licensing components version 2023.12
*  Synopsys Common Licensing version 2022.12

For Nodelocked and Network (Server Installation) installations, the CODE V installer configures the
Synopsys Common Licensing server as the Flexlm Service 1 service.

Error messages may refer to the "flex log", which is the log file for Synopsys Common Licensing. The
CODE V installer configures this log file to be named flexlog. txt in the
C:\Synopsys\licenses directory.

Synopsys Common Licensing always includes a Synopsys Common Licensing server. Even when you
have a nodelocked installation, there is an instance of the Synopsys Common Licensing server
running on your system. Therefore, even when you are not using a networked license, you may have
issues communicating with the Synopsys Common Licensing server.

Network
Network (Server)
Computer
Nodelocked
Computer
SCL Server
CODE V ] | ]
Application Network (Client) g - Network (Client)
t Computer Computer
SCL
Server
CODEV , CODEV
Application Application
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There are no remaining licenses for the requested feature

Licensed number of users already reached.

A limited number of users can use this feature at the same time, and the limit has been reached.

If you are running multiple sessions concurrently, you may have reached the maximum concurrent
session limit.

For network licenses, please wait for other users to end their feature usage, then try again.

To further check license usage at your site, please contact your SCL license administrator.

The license does not include the requested feature

No Such Feature Exists

The license file found does not contain a valid feature for this version of the software.

Please check with your site manager for the valid features.

Cannot connect to the license server system

Cannot connect to license server system

The license server manager (Imgrd) has not been started yet, the wrong port@host or license file is
being used, or the port or hostname in the license file has been changed.

This error can occur because of the following reasons:

(Imgrd) daemon is not running

The CODE V installer configures this as the Flexlm Service 1 service. Confirm that the
Flexlm Service 1 is running on your Nodelocked or Network (Server) system. If you cannot find
the FlexIm Service 1 service, try the following:

— Reboot the system
— Configure your licensing again

See Modifying License Options for Synopsys Common Licensing Nodelocked Licenses on page
43 or Modifying License Options for Synopsys Common Licensing Network Licenses on page
50 to reconfigure the selected license type.

— Contact CODE V Support
Wrong port/host or license is being used

See Modifying License Options for Synopsys Common Licensing Nodelocked Licenses on page 43
or Modifying License Options for Synopsys Common Licensing Network Licenses on page 50 to
update the host name and port number for the license server.

License file is expired

If your license agreement is current, you can request an updated license from SolvNetPlus or from
CODE V Support.

If you need to renew your license agreement, contact optics@synopsys.com or your local distribu-
tor.
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» License file contains an invalid Host ID
Contact CODE V Support
* License file is not installed

See Modifying License Options for Synopsys Common Licensing Nodelocked Licenses on page 43
or Modifying License Options for Synopsys Common Licensing Network Licenses on page 50 to
install the license file.

For nodelocked licenses, there are situations where the licensing processes can be stopped and will not
automatically restart. When you try to start the software you will get the Cannot connect to
the license server system error. Under these circumstances you will need to restart your
computer to get the licensing processes to restart.

A connection to the Synopsys Common Licensing license manager was lost

The complete error message is A connection to the Synopsys Common Licensing
license manager was lost, and the application has exhausted all of
its retry attempts.

Cannot connect to license server system.

For network licenses, check your network connection to your network license server.

For nodelocked licenses, try rebooting your computer, then try again.

If the error persists, contact codev_support@synopsys.com or your local distributor.

Include the following:

e A screenshot of the License Manager Error window

e The following files from the 1icenses folder (by default, C: \Synopsys\licenses):
- opslic.txt

- flexlog.txt

The license request was denied by the network license server
This error message can be received from multiple scenarios.
* The User/Host on EXCLUDE list for feature (FlexNet Licensing error: -38, -101)
» User/host not on INCLUDE list for feature (FlexNet Licensing error: -39)
* Checkout exceeds MAX specified in options file (FlexNet Licensing error: -87)
Please contact your SCL license administrator.
This error can occur for one of the following reasons:
* Max limit of users has been reached.
*  You have been excluded from using this feature.

¢ The feature is reserved for others.
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Time Tamper Error
A problem with the system clock has been detected.

This error may indicate that the system clock is currently set incorrectly, or has been set incorrectly in
the past. Contact codev_support@synopsys.com or your local distributor and provide a copy of the
error message, including the Host ID mentioned in the error message.

CODE V cannot find the Synopsys licensing service/daemon (snpsimd)

The Synopsys licensing service/daemon (snpslmd) is either down or inaccessible. The Synopsys
licensing service/daemon can terminate because of the following reasons:

* All the features are expired for this version of the software.
* The license file is corrupted.
* The license file contains an invalid server Host ID.

If you are using a network license, your connection with the computer hosting the license service/
daemon may have been interrupted. Check your network connection.

Firewall(s) must be configured to allow the Synopsys Common Licensing server (Imgrd.exe and
snpslmd.exe) to communicate on ports 27020 and 27021. If you get an error such as a -96 FlexNet
Licensing error, make sure both ports are open in any firewalls.

If you are using a nodelocked license, confirm that the Flexlm License 1 service is running.

Uninstall Synopsys Common Licensing

If instructed by CODE V Support, you can remove the Synopsys Common Licensing components
from a system. Note that the Remove option in the CODE V installation wizard does not remove the
Synopsys Common Licensing components.

Caution: Do not remove the Synopsys Common Licensing server unless you have confirmed that no
other Synopsys products are using the Synopsys Common Licensing server instance.

The CODE V installer automates the installation and configuration of two Synopsys Common
Licensing components. However, after installation the installer treats these components as separate
installations and they are not included when you run the CODE V installation wizard and select the
Remove option to uninstall CODE V.

Follow these instructions to remove the Synopsys Common Licensing components.
1. Log in to your system as an administrator.

2. Open Add and Remove Programs.

3. Uninstall Optical/Photonic Solutions Licensing.

4. Uninstall SCL Version.

5. Restart the system.

6

. (Optional) Delete the C: \Synopsys folder only if you have no other Synopsys applications
using that folder.
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Glossary

Client (machine)

The client, or client machine, is a computer that has CODE V installed on it, and is con-
figured to request a license from a license server. For CODE V Legacy Licensing, this
machine runs software that uses a floating license. For Synopsys Common Licensing,
this machine runs Network Client software, which uses a network license.

CODE V Legacy Licensing The method of licensing used in releases up to and including CODE V 2024.03. It is

Fixed License

Floating License

Host ID

License Key file

License Server

Network License

Nodelocked License

Site ID

SmartKeys

based on the Sentinel RMS™ License Manager.

Used with CODE V Legacy Licensing. A license associated with a specific USB don-
gle.

Used with CODE V Legacy Licensing. A license managed by the OSG Floating
License Manager.

A string used to identify a computer or a USB dongle. The Synopsys SmartKeys site
and delivery email reference the Host ID value when license key files are requested and
delivered.

A file containing the encoded license information that defines how CODE V may be
used. Note that license key files are unique for each licensing method—ILegacy and
SCL—and are not interchangeable between the two methods. In an implementation
where licensing is centrally managed by a license server, a license key file is installed
only to the license server and not on its managed clients. In an implementation where
licensing is not centrally managed, each computer running CODE V must have its own
license key file.

The computer that hosts the software that regulates and protects application use on cli-
ent machines. The license server communicates with client machines over the network
to manage their licenses. Note that License Server Software must match the method of
licensing used by its clients.

CODE V Legacy Licensing is based on Sentinel RMS™ and installs an OSG Floating
License Manager. Synopsys Common Licensing is based on FlexNet Licensing and
installs a Synopsys Common Licensing server.

Used with Synopsys Common Licensing. A license managed by the Synopsys Common
Licensing server.

Used with Synopsys Common Licensing. A license associated with a
specific computer or USB dongle.

A unique number used to identify a specific company. Every company that uses
CODE V and other Synopsys software has a unique site ID.

The SolvNetPlus page where you submit license key requests.
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SolvNetPlus The Synopsys customer portal (https://solvnet.synopsys.com). Customers who register
for an account on this site can download CODE V software and licensing software, and
request license keys.

SolvNetPlus also provides access to technical articles, example files, macros, release
notes, and FAQs, as well as product documentation, product learning, self-help, and
other resources..

Synopsys Common The license management tool used by Synopsys. This method of licensing is available
Licensing (SCL) starting with CODE V version 2023.03. It is based on FlexNet Licensing.
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